
SIMATIC HMI Getting Started Basic Panels 

____________________________

______________
______________
______________
______________
______________
______________

Welcome 1
 

Creating a project 
 

2
 

Configuring Screens 
 

3
 

Configuring alarms 
 

4
 

Configuring recipes 
 

5
 

Configuring screen changes
 

6
 

Finishing the project 
 

7
 

Transferring and using a 
project 

 

8

 

SIMATIC HMI

  
Getting Started Basic Panels 

Getting Started 

04/2009 
A5E02529524-01 

 



 

 

Legal information   Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes 
in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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 Welcome 
  

G
G

Welcome to WinCC flexible "Getting Started - First Time Users."  
Using an example of a fruit juice mixing system, this manual will illustrate how easy it is to 
create the user interface for an HMI device using WinCC flexible. 
The fruit juice mixing system produces juice, nectar and beverage drinks in the flavors 
orange, apple and tropical. The necessary ingredients are available in four supply tanks. 
The ingredients are mixed in mixing tanks and then filled. 
The fruit juice mixing system operator can perform the following tasks: 
● Control the fill level in the supply tanks 
● Monitor the status of the supply line valves 
● Enter and transfer mixture ratios 
In order that the operator can perform these tasks, the user interface of the HMI device must 
be "configured." The configuration steps necessary to do this are explained in the "Getting 
Started - First Time Users manual": 
● Creating a project (Page 6) 
● Configuring Screens (Page 20) 
● Configure alarms (Page 28) 
● to configure recipes (Page 38) 
● Configure screen changes (Page 46) 
● Finishing the project (Page 56) 
● Transferring and using a project (Page 64) (optional) 
 

 

R
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"Configuring" relates to the creation and configuration of the user interface for an HMI 
device. 

equirements 
The "CD_1" folder of the enclosed WinCC flexible DVD contains programs that will allow you 
to carry out these configuration steps by yourself. In addition, install the WinCC flexible 
edition "Compact", "Standard" or "Advanced" on your configuration computer.  
The following components are used for the example in this "Getting Started - First Time 
Users" manual: 

 
Only the configuration computer is required for the configuration steps mentioned. 
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2.1 2.1 Projects in WinCC flexible 
A project brings together all the information of a configured user interface. The project forms 
the basis of the configuration.   
Create and configure all the objects in the project which are necessary to operate and 
monitor the fruit juice mixing system, for example: 
● Screens, to depict and operate the fruit juice mixing system. 
● Tags, to transfer data between the HMI device and fruit juice mixing system. 
● Alarms, to indicate the operating status of the fruit juice mixing system on the HMI device. 

2.2 2.2 Creating a project 

The Project Wizard    
1. Start WinCC flexible. 

2

43

1

 
The WinCC flexible project wizard opens. The project wizard provides supports when 
creating a project by guiding users step-by-step through the configuration settings. The 
project wizard has various scenarios for frequently required configurations. Complete the 
configuration settings for your project by selecting the scenarios provided.  
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2. Create a new project. 

 
3. To operate the fruit juice mixing system, only one HMI device and one control unit are 

needed. Select the scenario "Small machine" and accept the selection with "Next". 

1

2
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4. Configure the scenario. 
– Select your HMI device and enter the version of the HMI device. The information on 

device type and version are available on the back of your HMI device. 
– Accept the default setting "IF1 B" as connection for the "Getting Started" project. 
– Use the predefined "SIMATIC S7 300/400" as PLC. 
– Accept the settings with "Next". 

1

5

4

3

2

 
5. Click on "Next" to apply the standard settings provided on the next page "Screen 

template." 
6. Click on "Next" to apply the standard settings provided on the next page "Screen 

navigation." 
7. Click on "Next" to apply the standard settings provided on the next page "System 

screens." 
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2.2 Creating a project 

 
1

8. Click on "Next" to apply the standard settings provided on the next page "Libraries." 
9. Now enter the information on the project and create the project with "Finish". 

4

2

3
1
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This "Getting Started" shows the principles of configuration using the "KTP600 Basic" HMI 
device as an example. You can apply the same configuration process to other HMI 
devices. Some steps in the configuration sequence may be different for a given HMI 
device. Additional information is available in manual for your HMI device and in the WinCC 
flexible online help. 
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2.3 2.3 The new project 

Introduction 
You have created the project with the project wizard. 
In this section you will be introduced to the WinCC flexible software interface.  

The WinCC flexible interface 
The project wizard creates the new project according to the information specified and opens 
it in WinCC flexible.  

 
On the left you see the Project View with its tree structure. In this window, you have access 
to the project properties and the device settings of the HMI device. The tree structure 
includes all elements of the project. You open all elements, such as configurable objects and 
available editors, from this window. The number of available elements depends on the range 
of functions offered by the HMI device. 
The HMI device is shown in the central Work Area. You edit all configurable objects of the 
project in the work area. All windows of WinCC flexible are arranged around the work area. 
With the exception of the work area, you can size, move, pin or hide all windows. You show 
hidden windows using the "View" menu. 
The Property View is used to edit object properties, such as size or color of screen objects. 
The configurable properties may differ with the object. The property view is only available in 
specific editors. 
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The Toolbox on the right includes objects, graphics and other elements required for the 
configuration. The window is divided into several areas:  
● "Simple objects" includes preconfigured objects, such as I/O field, button, graphics and 

text field. 
● "Advanced objects" includes objects with extended functionality, such as alarm windows. 
● Graphics includes a collection of images to create screens and objects. 
● The library area offers access to objects you have created yourself as well as external 

objects, such as your own collection of graphics or objects from other projects. 

The new project 
The project wizard has automatically created some objects you can configure in the Project 
view: 
● Screens 
● Connections 

Screens 
The "Template" screen is available under "Screens" in the project tree. 
The "Start screen" of the HMI device is automatically opened in the work area to the right of 
the tree structure. You will see two overlapping alarm windows in the display of the HMI 
device. The gray shading of the Alarm Window indicates that this alarm window is inserted in 
the "Template" screen. The Error Alarm Window and the System Alarm window are required 
for later operation of the HMI device on the fruit juice mixing system.  
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The error alarm window shows pending faults in the plant. 
The system alarm window shows configured alarms for the operating states in the plant. 
An alarm indicator directs your attention to pending alarms or those 
requiring acknowledgment. 
The total number of alarms is displayed under the "Caution" symbol in the 
alarm indicator. 
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Connections 
With the scenario configured in the project wizard you have already defined the 
"Connections" between HMI device and PLC: 

 

Customizing the template 
Objects inserted in the "Template" are those which should appear in every screen, such as 
the previously mentioned alarm windows. A screen consists of 32 layers. The top layer, 
"Layer 0", is the standard view of the screen. Objects, such as alarm windows, that are to be 
visible in standard view, will be added below the top layer. 
Because the alarm windows are to appear only when a message occurs while the fruit juice 
mixing machine is in operation, you can suppress the permanent display of the alarm 
windows during configuration. To do this, deactivate the level in which the alarm windows 
are inserted.  
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Under "Options > Settings" you can hide all template objects independent of the levels.  
The objects will then no longer be displayed on the screens during configuration. All 
objects included in the template will be reported in the project documentation. 
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1. Open the "Template" screen with a double click: 

 
2. Minimize the window so that you will be able to see the alarm indicator below: 
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3. Hide the layers with the alarm windows (1, 2) and close the template (3). 

1

2

3

 

Setting up the workbench area 
The WinCC flexible Workbench consists of individual windows which can be arranged as 
required around the work area. The following section describes how to "dock" the Object 
view in the Project view.  
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"Docking" refers to the integration of a window into the WinCC flexible workbench.  
You can automatically hide docked frames in order to increase your workspace. 
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1. Unhide the Object view (1) and configure the view so that it is not automatically 
hidden (2): 

 

2. Move the Object view into the Project view and dock the frame as soon as the gray frame 
has adapted to the Project view: 
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3. The Object view contains the contents of the area selected in the Project view, such as 
Screens: 
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Resetting window arrangement 
Docking the window in the desired position does take some practicing. For this reason, the 
arrangement of the windows can be reset to their original setting at any time: 

3

5

4

2

1
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Interrupting configuration 
You can stop configuration at any time and continue later.  
● If you want to interrupt configuration, save the project (1). 
● Select a suitable storage location and save the project with a self-explanatory 

name (2, 3): 

3

1

2

 
The next time WinCC is started, the project is displayed in the project wizard: 

1 2

 



 

 Getting Started Basic Panels 
20 Getting Started, 04/2009, A5E02529524-01  

Configuring Screens 3
 

 



 Configuring Screens 
 3.1 Function of the screens 

Getting Started Basic Panels 
Getting Started, 04/2009, A5E02529524-01 21 

3.1 3.1 Function of the screens 
A user interface consists of several related screens. Screens enable you to operate and 
monitor a plant and are the main elements of the project.  
Screens are displayed on the HMI device and consist of configurable objects: 
● Operable objects, such as alarm windows, IO fields or buttons. 
● Objects to display values, such as trend view and bars. 
● Informative objects for the description of objects or screens, such as text fields or graphic 

fields. 
You can drag-and-drop these objects from the toolbox directly into a screen. 
The figure below shows the fill level indicator as an example for our project: 

 
The user interface of the fruit juice mixing system is comprised of four screens. The operator 
uses the fill level indicator to monitor the fill levels of the storage tanks. 
The following section explains the configuration of the fill level indicators for water, 
concentrated juice, sugar and flavoring. The fill levels should be indicated on the HMI device 
both graphically and numerically.  
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3.2 3.2 Configuring fill level displays 

Configuring fill level displays   
The following objects are required to configure the fill level displays: 
● Tags to store the fill levels 
● Output fields for displaying fill levels in numeric form 
● Bar graphs for displaying fill levels graphically 
● Text fields for labeling 
The following steps will show you how to configure these objects. 

Creating fill level tags 
1. Create a tag called "FillLevel_Water" which stores the fill level of the water: 

1

2

 
2. Configure the tag: 

– Enter the name "FillLevel_Water". 
– The connection "Connection_1" has already been entered. 
– Set the data type "Int" for integer because decimal numbers are used for the fill levels. 
– Set the storage area in the PLC that contains the current value of the tag. 

Make sure that "Name" and "Address" match with the associated process tag in the 
S7 control program. Information on process tags are available in the WinCC flexible 
online help. 

21
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3. In the same way, create the tags "FillLevel_Concentrate", "FillLevel_Sugar" and 
"FillLevel_Aroma": 

 
 

C
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The process tags of the PLC will store the tank fill levels which are determined by 
measuring transmitters. If the configured tags have been configured to match the 
associated process tags, then the data in the PLC and HMI device will be compared by the 
set connection. 

reating a new screen to show fill levels 
1. Create a new screen: 

 
2. Use "FillLevels" as the new names: 
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2

Creating an output field for numeric fill level display 
1. Insert an IO field in the screen in which the water fill level can be displayed: 

1

32

 
2. Configure the output format of the IO field in the Properties view: 

1
2

3

 
3. Resize the IO field: 

1

2
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If you drag a tag from the Object view to the screen using drag-and-drop, an input/output 
field (IO field) will be created automatically which is connected to the tag. 
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Creating a bar graph for displaying the fill level graphically 
1. Insert a bar in the screen: 

1

2

 
2. Configure the bar graph in the Properties view: 

– Enter the volume of the tank (1) and select the "FillLevel_Water" tag (2, 3). 

2

3

1

 
– Adapt the size (2) and align the bar to the right (3, 4): 

1

4

3
2
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– Deactivate the scale indicator: 

1

2

 

Creating a text field to label the fill level display 
1. Insert a text field in the screen: 

 
2. Enter a "W" for water in the Properties view: 

 
3. In the same way, create another text field labeled "l" for liters. 
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Arranging the text fields, bar graphs and output field. 
1. Position the two text fields, bar graphs and IO field in the display using the cursor keys: 

 
2. Match the size of text and display of the configured objects to your display. 

With the TP1500 Basic you will reserve a part of the screen area for buttons. 

Adding the fill level displays for juice, sugar and flavoring 
1. In the same way, create the fill level displays for juice, sugar and flavoring: 
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You multiply the elements of the fill level display quickly with copy and paste. 
"Copy&Paste" saves time when creating objects. Make sure that the correct tags are 
interconnected with the IO fields. 

The fill level display is configured. When the system is running, the operator can read the 
current fill levels of the tanks on the HMI device.  
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4.1 4.1 Alarms in project 
Alarms indicate events or operating states which occur or prevail in the fruit juice mixing 
system. Alarms can be used, for example, for diagnostics purposes when clearing faults. 
Alarms are differentiated as follows: 
● Discrete alarms indicate changes of status in the fruit juice mixing system and are 

triggered by the controller. They indicate, for example, whether a valve is open or closed. 
● Analog alarms indicate a value has moved outside the limits of the permitted range. 

An analog alarm is triggered, for example, when the speed of a motor drops below a 
specific value.  

An alarm view makes it possible for operators to get information about the operating status 
of a plant.  
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4.2 4.2 Configuring discrete alarms 

Introduction 
Each tank in the fruit juice mixing system is equipped with an inlet valve. The following 
section explains how to configure an alarm display in which the states (open or closed) of the 
inlet valves for water, juice, sugar and flavoring are shown. 
When a valve opens or closes during operation, the corresponding discrete alarm is 
triggered. 

Creating tags to store the states   
The states of the valves are stored in the "Valve_Status" tags. Each status is assigned a bit 
in the tag.  
● Water valve: Bit 0 and Bit 1 
● Juice valve: Bit 2 and Bit 3 
● Sugar valve: Bit 4 and Bit 5 
● Flavoring valve: Bit 6 and Bit 7 
1. Create the "Valve_Status" tag: 

1
2

 
2. Configure the tag: 

21
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Creating alarms for status display 
1. Create a new discrete message: 

2

1

 
2. Create the discrete alarm in the Properties view: 

– Enter "Valve (water) open" (1) and select the alarm class "Warnings" (2, 3): 

3

2

1

 
– Select the tag in which the status of the valve is stored. 

3

21
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3

– Select the bit number which represents the "open" status: 

 
When the water tank valve opens, the discrete alarm "Valve (water) open" is triggered. 

3. In the same way, configure the discrete alarm "Valve (water) closed" which represents 
the "closed" status. 

4. Configure the discrete alarms for the "juice", "sugar" and "flavoring" valves in the same 
way: 
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Add a second discrete alarm by double-clicking the next empty line. The settings of the first 
discrete alarm will be adapted. The alarm number and bit number are automatically 
incremented. Now adjust the text. 
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4.3 4.3 Configuring analog alarms 

Introduction 
The fruit juice mixing system's mixing tank is equipped with a mixer whose speed must be 
monitored. When the speed moves outside the upper or lower limit value, the corresponding 
alarm should appear on the HMI device. 

Creating the tag to store the speed 
The speed of the mixer is stored in the "Mixer_Speed" tag.  
1. Create the "Mixer_Speed" tag: 

1

2

 
2. Configure the tag: 

21
 

3. In the Property view, select the "Cyclic continuous" mode under "General". 
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Cyclic updates of tags add to system load. Use cyclic updates only within the scope of the 
system limits (WinCC Information System > Performance > System Limitations). 
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Creating alarms for speed monitoring   
1. Create a new analog alarm: 

2

1

 
2. Configure the analog alarm in the Properties view: 

– Enter "Mixer Speed too high" (1) as the alarm text and select the alarm class "Errors" 
(2, 3): 

3

2

1

 
– The speed of the mixer is to be stored in the "Mixer_Speed" tag. Select the tag 

"Mixer_Speed". 

3

21
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– Enter "800" as the maximum valid speed: 

 
– Select "On rising edge": 

 
3. Similarly, configure the "Mixer speed too low" alarm. The alarm should be triggered if the 

speed drops below 400 (at "falling edge"). 
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The settings from the first analog alarm are transferred to the second analog alarm settings 
by double-clicking in the empty line. You will only have to adapt the settings. The alarm 
number is automatically incremented. 
Alarms of the "Errors" alarm class must be acknowledged by the operator. 
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4.4 4.4 Configuring an alarm view 

Introduction 
Error alarm windows inform operators about irregularities during operation of the plant. Error 
alarm windows are available in the template for this project so that they will be displayed in 
each screen in case of an error. 
The alarm view shows all the error alarms and warning alarms which have occurred to date. 
The following steps will show you how to configure an alarm view. 

Creating an Alarm View   
1. Create a new screen: 

 
2. Use "Messages" as the new names: 
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3. Drag the alarm view into the display: 

2

1

 
4. Adjust the size of the alarm view screen on your display. 

When using a TP1500 Basic leave an area free for buttons. 
5. Configure the alarm view in the Properties view: 

– Select the alarm classes which are displayed in the alarm view: 

2
1

 
– Make the necessary selections so that the last incoming message is displayed in the 

first line and the alarm text is displayed with the time: 

1 2

 
When the system is in operation, the status of the water, juice, sugar and flavoring tanks 
appear on the screen "FillLevels". 
The operating states of the valves for water, juice, sugar and flavoring are listed in the alarm 
view. 
Deviations in mixer speed are shown as error alarms with time in a separate error alarm 
window and recorded in the alarm view.  
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5.1 5.1 Function of the recipes 
A recipe contains a combination of related production data, such as mixing ratios. A mixing 
ratio can be transferred from the HMI device to the fruit juice mixing system in a single 
working step in order, for example, to switch production from orange juice to orange nectar. 
The fruit juice mixing system can produce drinks with "orange", "apple" and "tropical" flavors. 
A recipe is created for each flavor. The ingredients required for each flavor are defined in the 
recipes. 
In turn, each recipe contains three recipe data records in which the mixing ratios for "juice", 
"nectar" and "beverage" are stored. 
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Recipes collect production parameters in parameter records that are easy to use.  
Recipes enable the fruit juice production to be switched to other mixing ratios or flavors in 
the simplest of ways. 
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5.2 5.2 Configuring a new recipe 

Introduction 
The following section explains how to create the "Orange" recipe together with the 
associated mixing ratios for juice, nectar and beverage. 

Creating a recipe for the "Orange" flavor   
1. Create a new recipe: 

 
2. Enter the name and view name for the recipe: 

21

 

Creating tags for the quantities of the ingredients 
Four tags are required in order to transfer the mixing ratios to the fruit juice mixing system. 
Each tag contains the quantity of one of the ingredients. 
1. Create the tags "Litre_Water", "Litre_Concentrate", "Kilo_Sugar" and "Gram_Aroma" with 

the following settings: 
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Creating recipe elements for the ingredients 
One recipe element is required for each ingredient, in this case water, juice, sugar and 
flavoring. 
1. Create a new recipe element "Litre_Water": 

1

2

 
2. Enter the name and view name for the recipe element: 
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3. Link the recipe element with the "Litre_Water" tag: 

2

1

 
4. In the same way, create the recipe elements "Litre_Concentrate", "Kilo_Sugar" and 

"Gram_Aroma": 
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Entering mixing ratios 
A specific quantity of the ingredients is required for each individual drink "juice", "nectar" and 
"beverage." The mixing ratios are stored in the recipe data records. 
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The mixing ratios can also be entered in external programs, such as MS Excel, and 
imported on the HMI device. 
An example for such a file is available on the WinCC flexible DVD in the 
"CD_3\Documents\[Language]Getting Started" folder. For additional information, refer to 
the documentation for WinCC flexible. 

1. Create a new recipe data record called "Beverage": 

1

2

 
2. Enter the name, view name and number: 

 
3. Enter the quantities of the ingredients: 

 
4. In the same way, create the recipe data records for "Nectar" and "Juice": 
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5.3 5.3 Configuring a Recipe view 

Introduction   
The operator is to change and manage the recipes on the HMI device during operation. This 
step requires a recipe display that offers the following commands: 
● Create recipe data record 
● Save recipe data record 
● Delete recipe data record 
● Transfer recipe data record to fruit juice mixing system 
● Read recipe data record from fruit juice mixing system 
To do this, a Recipe view is inserted: 
1. Create a new screen: 

 
2. Use "Recipes" as the new names: 
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3. Drag the Recipe view into the display: 

 
4. Enable the functions in the Property view that should be available in the Recipe view. 

21

 
5. Then define the following view settings: 

31

2
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6.1 6.1 Creating a Selection screen 
The Selection screen shows the operator which key must be used to switch to a specific 
screen on the HMI device and back to the Selection screen. The operator is guided to create 
the Selection screen and linking the screen change. 
The screen changes are assigned to the function keys <F1> to <F4> on the HMI device in 
our example. The <F5> key should be used to switch off the HMI device.  

Procedure 
1. Open the "Start Screen" screen: 

 
2. Rename the "Start Screen" screen: 

1

2

 
3. Use "Selection" as the new names: 

 
4. Delete the following objects in the screen: 

– the text field with the screen name "Start screen" 
– the button with the text "Start screen" 
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5. Create five text fields with the following content: 
– "F1 = Fill level" 
– "F2 = Alarms" 
– "F3 = Recipes" 
– "F4 = Choices" 
– "F5 = Exit" 

 
6. Define the start screen in the "Device Settings" of the Project view: 

– The start screen will always be displayed first when you start the HMI device. Because 
the "Start screen" created with the Project wizard was adapted, the "Selection" screen 
has already been entered as start screen. 

1
3

4

2
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6.2 6.2 Configuring screen change with function keys 

Configuring global screen change with function keys   
1. Open the template: 

 
2. Assign the change to "FillLevels" to function key <F1>: 

3

1

2

 
On pressing the <F1> function key on the HMI device during operation, the screen with 
the fill levels appears in the display. 

3. Assign the change to "Messages", "Recipes" and "Selection" on the function keys <F2>, 
<F3> and <F4>. 
etting Started Basic Panels 
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Function keys configured in the Template will have a global effect. The same function will 
be triggered in each screen with the same key. You can also configure the functions of the 
keys individually in the respective screen. 
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Configuring deactivation of the HMI device 
The finished project represents the user interface of the HMI device. The user interface will 
be started and displayed automatically when you turn on the HMI device. 
1. Open the "Selection" screen: 

 
2. Assign the "StopRuntime" system function to the <F5> key: 

2

1

4

3

 
3. Save the project with "Project" > "Save" in a directory of your choice for the settings to 

become effective. 
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Project names including the .hmi extension may not exceed a length of 120 characters. 
The path name including the .hmi extension may not exceed a length of 218 characters. 
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6.3 6.3 Configuring screen change with buttons 

Introduction 
There are no function keys on the TP1500 Basic. You configure buttons in the Template that 
will trigger the screen change. These buttons are displayed in all screens and have a global 
effect. 

Configuring global screen change with buttons   
1. Open the template: 

 
2. Insert a button into the screen. 
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3. Assign the change to the "FillLevels" screen to the button: 

1

2 3
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4. Type in the button name "F1". 
On pressing the "F1" button on the HMI device during operation, the screen with the fill 
levels appears in the display. 

 
5. Configure the following buttons with screen changes: 

 

Labeling Screen change to 
F2 "Messages" 
F3 "Recipes" 
F4 "Selection" 
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Buttons configured in the Template will have a global effect. The same function will be 
triggered in each screen with the same button. 
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Configuring deactivation of the HMI device 
The finished project represents the user interface of the HMI device. The user interface will 
be started and displayed automatically in Runtime when you turn on the HMI device. 
1. Open the "Selection" screen: 

 
2. Configure a button and name it "F5". 

1

2
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3. Assign the "StopRuntime" system function on the "Press" event of the button: 

1

2

4

3

 
4. Save the project so that the settings take effect. 
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7.1 7.1 Consistency check and simulation 
Your inputs will be checked during configuration. The tag of the "Byte" data type can have a 
value between 0 and 255. Input will be rejected if you attempt to enter a value greater than 
255. Incomplete configurations, such as an IO field without assigned tag, will not be checked 
at input. Such errors will be detected by the consistency check during compilation and listed 
in the Output window. 
If WinCCflexible was installed with the Simulation/Runtime component, you can simulate the 
project with the Runtime Simulator. The Simulator changes the values of the configured tags. 
Selection of the tags and the change of values takes place via a simulation table. This 
enables you to check the functions and processes of the configuration without connection to 
a PLC. 
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The program only simulates the tags in the configuration if no PLC is connected. 
If a PLC is connected, then the Simulator will change the values of the respective process 
tags in the S7 program. The configuration is simulated together with the PLC. This means 
you can check to see if the values are transmitted correctly between process and project 
tags. 
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7.2 7.2 Running the consistency check 

Introduction 
You have just created your first project. Before the configuration is concluded, the project 
can be tested and simulated using the migration consistency check function and the 
simulator provided by WinCC. 

Check project for consistency   
The consistency check determines missing links, violation of value ranges and incorrect 
settings. 
1. You start the consistency check by compiling the project once again: 

– This function is available under "Project > Compiler > Compile". 

 
The result of the consistency check appears in the Output view: 
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If there no errors or warnings have occurred during compilation, the project can be 
simulated. 
If an error has occurred, you can jump directly from the context menu to the error location 
in the project by double-clicking the error entry in the output window. 
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7.3 7.3 Simulation in Runtime 

Introduction 
The simulation function helps you to find logical configuration errors, such as incorrect limit 
values.  
The following sections explains how to simulate the fill level indicator and alarms for the 
valve states.  

Creating a simulation table   
1. Start the simulator: 

 
The Simulator and the simulation table will be displayed. 

2. Select the "FillLevel_Water" tag in the simulation table and enter the simulation values: 

1
2

3

 
The WinCC flexible Runtime Simulator is controlled via the displayed simulation table. 
You select configured tags in the "Tag" column and enter them consecutively in the lines 
of the table. The properties of the tags are shown in the columns "Data Type" and 
"Current val." with yellow shading. The entries in the white columns are the simulator 
settings and control the simulation process. 
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3. Complete the simulation table with the tags "FillLevel_Concentrate", "FillLevel_Sugar", 
"FillLevel_Aroma" and "Valve_Status": 

 
4. Save the simulation table 

1

32
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Simulating the project 
1. Start the simulation: 

 
If you activate the "Start" option of a tag, you will start the simulation of this tag. The 
Simulator alters the value of the tag according to the selected setting.  
For a reliable function test, you should select the settings of the Simulator so that they 
correspond to the function of the tag. Tags whose values depend on each other can be 
simulated together. 
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2. Change to the "FillLevels" screen and observe how the fill levels change: 

 
3. Change to the "Messages" screen and observe how the alarms on the valve status are 

triggered: 
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4. Change to the "Recipes" screen and open any recipe data record: 

3
2

1

4 5
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You can operate the device representation in the simulator window. Acknowledge the 
pending error alarm with the corresponding function of the alarm window in the display of 
the HMI device. 
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8.1 8.1 Overview 
You have created the graphical user interface for your HMI device in the project. You have 
created tags to read out process values from the PLC or to transfer them to the PLC.  
The following requirements must be met to use the project on the HMI device: 
1. The HMI device is connected to an matching power supply. 
2. Your configuration PC comes equipped with a matching interface adapter and is 

connected with your HMI device. 
If these conditions are met, the following steps will be executed: 
● Check connection parameters 
● Transfer the project to the HMI device 
● Operating a project on the HMI device 
These requirements and steps apply even if the project was created for a different HMI 
device instead of an KTP600 Basic. 
If you have access to a SIMATIC S7-300/400 PLC, you can upload a prepared S7 program 
to the PLC to actively simulate your project on the HMI device together with the PLC. 
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8.2 8.2 Requirements 

Power supply 
The HMI device is connected to an matching power supply. 
The HMI device is designed for power supply through a SIMATIC PLC. The power supply 
must meet the following requirements: 
● Use only 24 VDC power supply units with safe electrical isolation in accordance with IEC 

60364-4-41 or HD 384.04.41 (VDE 0100, Part 410), for example, in accordance with the 
PELV standard. 

● The supply voltage must be within the specified voltage range for your HMI device. The 
power consumption may not exceed the value specified for your HMI device. Otherwise, 
malfunction at the HMI device cannot be ruled out. The information is available in the 
operating instructions or on the rating plate on the back of the HMI device. 

● For non-isolated design: Connect the "GND" connection from the 24 V power supply 
output to equipotential bonding for a uniform reference potential. You should always 
select a central point of termination. 

● Only qualified personnel may connect and commission the HMI device according to the 
operating instructions. 

Connection with the configuration PC 
Your PC has to be equipped with the matching interface to connect the configuration PC with 
the HMI device. 
The connection requires an MPI interface card installed in the PC or an external adapter. If 
an MPI interface card is installed in your PC, you will be able to connect the HMI device 
using the matching MPI cable. 
The following external adapters are available at http://mall.automation.siemens.com: 
● Serial USB/PPI cable, order number 6ES7 901-3DB30-0XA0 
● Serial PC/PPI cable, order number: 6ES7 901-3CB30-0XA0 
● MPI "PC Adapter USB", order number: 6ES7972-0CB20-0XA0 

Matching power supply, order number 6ES7972-0CA00-0XA0 

http://mall.automation.siemens.com/
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In this "Getting Started" we are using the "PC Adapter USB". 

 
The "PC Adapter USB" has its own power supply and you connect it to the configuration PC 
using the supplied USB cable. If the associated software is installed on the PC, the adapter 
will be detected automatically and offers a flexible MPI interface for connection of control and 
HMI devices.  
We have used the "PROFIBUS" MPI/DP interface in this project. This interface was set in 
your project under "Connections" as "Connection_1". 
Additional information on transfer is available in the operating instructions of the Basic 
Panels in the Internet (http://support.automation.siemens.com/WW/view/en/31032678) and 
the WinCC flexible online help. 
etting Started Basic Panels 
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Connect PN devices of the Basic Panels via Ethernet with the configuration PC. 
You save and restore data, transfer a project or update the operating system via MPI. 
You cannot update the operating system with "Reset factory settings" via MPI. 

http://support.automation.siemens.com/WW/view/en/31032678
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8.3 8.3 Check connection parameters 
The connection parameters define the data connection between HMI device and 
configuration PC. A successful transfer is only possible if the following settings are correct:  
● The settings configured under "Connections" in the project match the transfer settings of 

the HMI device. 
● The USB/PPI adapter was configured as active MPI interface to the HMI device. The 

settings match the settings in the project. 

Checking the connection parameters in the project 
1. Open the "Connections" editor: 

 
2. Check the settings you have made when creating the project with the Project wizard. 

The following addresses must be set: 
– HMI device: 1 
– PLC: 2 
The PLC and HMI device communicate with each other via an MPI network. 
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Checking the connection parameters of the adapter 
The parameter settings of the adapter are available in the Windows Control Panel of your 
configuration PC. 
1. Open the Windows Control Panel. 
2. Open the settings for the PG/PC interface with "Set PG/PC Interface". 
3. Check to see if the "PC Adapter USB" was set as interface for the configured MPI 

network. 
4. Check to make sure that the settings of the adapter under "Properties/MPI" match the 

configured settings. 
If the settings of the adapter do not match the settings in the project, then the adapter cannot 
transfer the project.  

Checking the connection parameters at the HMI device 
The transfer settings of the HMI device must match the settings in the project for the HMI 
device to receive the project data. 
1. Switch on the power supply of the HMI device. 

The HMI device starts. The Loader is displayed. 
2. Open the Control Panel by pressing the "Control Panel" button of the Loader. 
3. Press the "Transfer" button to open the "Transfer Settings" dialog. 
4. Activate the MPI/PROFIBUS channel in the "Transfer" window and open the advanced 

settings with the "Advanced" button. Make sure that the settings in the "Advanced" 
window match the settings in the project. 

8.4 8.4 Transfer the project to the HMI device 
After having checked the connection parameters, transfer the project data to the HMI device. 

Preparation 
You will have to set the HMI device to transfer mode so that it can receive the transmitted 
data. 
1. Switch on the power supply of the HMI device. 

The HMI device starts. The Loader is displayed. 
2. Select the entry "Transfer" in the Loader to switch the HMI device into transfer mode for 

data transmission. 
The HMI device switches to transfer mode. The dialog window displays the message 
"Connecting to host ...". 
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Transfer 
Transmit the project data to your HMI device: 
1. Start the transfer (1) in WinCC flexible. 

You can also start the transfer via the "Project > Transfer > Transfer settings" menu. 
2. Check the displayed settings for the transfer (2, 3) and start the transfer to your HMI 

device (4): 

4

2

1

3

 
3. Track the displayed transfer steps in WinCC flexible and on your HMI device. 

 

U
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When the project is transferred to the HMI device, a consistency check is automatically 
performed. If the project still includes errors, then the transfer will be interrupted with a 
corresponding error message. 
If the project you want to transfer is greater than the internal memory of the device, then 
the project will not be transferred completely and you will see a message to that effect. 

sing a project on the HMI device 
The HMI will restart automatically after successful transfer. Wait until the start process is 
complete and the Loader is displayed. The HMI device will start your project after a few 
seconds. 
You can now call up and observe the screens of your project on the HMI device or check the 
functions of the Recipe view. Because the configured tags are not altered, the displays will 
be static and no messages will be created.  
To operate the HMI device in a very realistic manner, the device has to be connected to an 
active S7 controller.  
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8.5 8.5 Using project with S7 controller 
You have successfully transferred and tested the project on your HMI device. 
The following paragraphs will describe the relationship between the HMI device and the 
controller. 
The following requirements must be met to use the configured HMI device on an S7 
controller: 
● The configured HMI device is connected to a functioning, isolated S7 300/400 controller. 
● An S7 program matching the project was transferred via the interface adapter to your 

controller. 
● The values of the process tags of the S7 program will alter to match the project. 

The function of the S7 controller 
In reality, the PLC processes a program that controls the processes in a machine or plant via 
control values. The control values correspond to the states of the individual parts of the 
plant; they are detected with tags that were defined accordingly as part of data blocks in the 
program. If the data blocks include tags that match the tags created in the project regarding 
function and addressing, then the values detected there will be compared to the process and 
project tags. Entries on the HMI device change the values of linked tags and will trigger the 
reactions of the controller. Process values are transferred in configured tags and displayed in 
the project. 
You need an S7 controller ready for operation to operate the project on the HMI device. The 
S7 controller must be isolated, which means the controller has to meet the following 
requirements: 
● There may be no connections between controller and real plant or parts of the plant. 
● The controller may not be located in the vicinity of components that carry dangerous 

electrical voltages. 
All you need is a laboratory setting on a DIN rail, consisting of a SIMATIC S7-300/400 CPU 
with matching power supply. Your HMI device has to be connected to the power supply of 
the controller and has to be connected to the CPU with an MPI or PROFIBUS bus cable. 
Information on this setup is provided in the operating instructions of the S7 components. 

 

WARNING  
Risk of injuries when touching components carrying line voltage! 
S7-300/400 modules are classified as open equipment. The danger of components carrying 
live voltage is given once the power supply is connected to the mains. 
S7 modules have to be installed by trained personnel according to the respective operating 
instructions on a grounded DIN rail. The mains connection has to be touch-protected 
according to applicable standards. 
S7 modules may only be installed in housings, control cabinets or electrical equipment 
rooms. Access must be key or tool controlled and limited to instructed and trained 
personnel. 
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The S7 program 
A matching control program has been prepared for your "Getting Started" configuration. It 
simulates the function of the configured fruit juice mixing plant in the connected S7 controller. 
The cyclic change of the values in the process tags triggers the configured alarms and the 
display of the fill levels will vary. You can now operate the project on the HMI device. 
The control program "S7_Mixing" is available in the "CD_3\Documents\[Language]Getting 
Started" folder on your data carrier or the WinCC flexible DVD.  
STEP 7 and the installed "PC Adapter USB" is required to transfer the control program to the 
S7 controller. Information on this step is available in the S7 online help or the S7 
Programming Manual. 
1. Start STEP 7 on the configuration computer and run the control program "S7_Mixing". 
2. Transfer the control program to the S7 control. 

 

WARNING  
 

Danger of unexpected movement or function of plant parts! 
The "Getting Started" S7 program does not include any safety functions. When using 
the program in the PLC of a real plant or machine, you may trigger functions 
involuntarily and endanger persons in the close vicinity. 
Do not transfer the "Getting Started" S7 program to the PLC of a real plant or machine. 
The PLC used for the "Getting Started" may not be connected to a functioning plant or 
its parts. The "Getting Started" S7 program was intended solely for use as part of this 
tutorial on a separate SIMATIC S7 controller. 

 

Using the project 
1. Start the power supply of the S7-CPU and the HMI device and wait until the start process 

has been completed. 
2. If the S7 program and your project were transferred successfully, you can operate the 

configuration on the HMI device, observe the change in fill levels and track the status 
messages in the alarm window. 

Result 
● By transferring the project to the HMI device you have successfully carried out the tasks 

in "Getting Started - First-Time Users" and created a runnable project. 
● You have become familiar with the basic use of your project by connecting the HMI 

device with the controller. You are now able to reproduce all steps of the simulation with 
an HMI device and PLC. 
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